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[bookmark: _Toc315358641]Word 2010 Section 508 Accessibility Checklist
Step 1. Perform manual tests
Use the checklist below to look for potential accessibility issues with your document that cannot be detected automatically.
List Formatting
[image: List Formatting]
Format lists so assistive technology users can easily navigate to a list, know what type of list they are reading, and the level of an item within a list. Read more about List Formatting, on page 9.
Complex Tables
[image: Complex Tables]
Format data cells so they are associated with the correct table header.   In Word, screen readers cannot identify the column header of merged or split cells. Therefore, convert the document to an accessible format. Read more about Complex Tables (Merged/Split Cells), on page 15.
Language Settings
[image: Language Settings]
Set the correct language for passages of text.  Screen readers pronounce words based on language setting and if passages of text are set to a different language than intended, screen readers will speak the passage with the incorrect pronunciation.  Read more about Language Settings, on page 18.
Document Properties
[image: Document Properties]
Include the document title and other information including author, subject, and keywords in the document properties.  Screen readers speak the file name rather than title of the document if the title attribute is empty.  Read more about Document Properties, on page 23. 
Color and Contrast
[image: Color and Contrast]
Make text readable and distinguishable from background colors, watermarks, and background images. Also, ensure the content is readable when viewed in High Contrast mode.   Read more about Color and Contrast, on page 30.
[bookmark: _List_Formatting]Step 2. Run the Automated Accessibility Checker for additional tests
1. First, save the document in .docx format.  If shown, “Maintain compatibility with previous versions of Word” must be unchecked. 
2. Second, start the Check for Accessibility. 
Read more about Running the Automated Accessibility Checker, on page 42.
[image: K:\Document Guides\New Word Interface\Word 2010\BPL content pages Word 2010\check accessibility icon.png]
Unclear Hyperlink Text
[image: Unclear Hyperlink Text]
Make hyperlink text meaningful, descriptive, and unique. Screen reader users often call up a list of links in a document, and a long list of links called “click here” does not provide enough information for them to know the link’s destination or purpose. Read more about Unclear Hyperlink Text, on page 46.
Unstructured Document
[image: Unstructured Document]
Logically structure documents using heading styles so assistive technology users can easily navigate the document.  Read more about Unstructured Document, on page 52.
Skipped Heading Level
[image: Skipped Heading Level]
Skipped heading levels give assistive technology users misleading document structure and make navigation more difficult. Read more about Skipped Heading Level, on page 58.
Repeated Blank Characters
[image: Repeated Blank Characters]
Screen readers speak “blank” for carriage-return characters. Hearing the word “blank” multiple times in a row disrupts reading flow.  Read more about Repeated Blank Characters, on page 64.
Objects Not Inline
[image: Objects Not Inline]
Objects that are not ‘inline’ with text, also called floating objects, are impossible to access with the keyboard, and therefore cannot be read by screen reader users.  Read more about Object Not Inline, on page 74.
No Header Row Specified
[image: No Header Row Specified]
Define table column headers so users of assistive technologies can associate data cells with the proper header. Read more about No Header Row Specified, on page 81.
Blank Table Rows or Columns
[image: Blank Table Rows or Columns]
Remove blank table rows or columns. Formatting the look of a table by using blank rows or columns make tables more difficult to understand and navigate by screen reader users. Read more about Blank Table Rows or Columns, on page 87.
Missing Alt Text: Tables
[image: ]
Add titles or summaries to tables, so that users of assistive technologies can comprehend the purpose and design of the table without going through the entire table. Read more about Missing Alt Text (Tables), on page 94.
Missing Alt Text: Picture, Text Box, Other Elements
[image: Missing Alt Text: Picture, Text Box, Other Elements]
Add alternative text to all non-decorative images and other objects in the document. Alternative text conveys information to readers who are unable to see.  Read more about Missing Alt Text (Picture, Text Box, Other elements), on page 101.
Check Reading Order 
This issue can be ignored. SSA discourages the use of tables for page formatting because layout tables create many accessibility challenges. If you must use tables for formatting/layout, convert the file to an accessible format and preserve the proper reading order when remediating for accessibility.  Therefore, ignore this automated test. 
Heading is Too Long 
This issue can be ignored. You should avoid long headings, but this is not a requirement of Section 508, and often unavoidable with government documents. Use plain and concise language for headers and otherwise ignore this test result.
Infrequent Headings 
This issue can be ignored. It is safe to ignore this test; it is a redundant test already covered by the ‘Unstructured Document’ test. 
Merged or Split Cells 
This issue can be ignored. Refer to “Complex Tables” section above, and ignore this automated test result. 
Using Image Watermark 
This issue can be ignored. Perform this test manually, with reference to the “Color and Contrast” section for guidance.
[bookmark: _List_Formatting_1][bookmark: _Ref314582173][bookmark: _Ref314582175][bookmark: _Toc315358642]List Formatting
[bookmark: _List_Formatting_2][image: ]
Requirements for 508 Compliance
Programmatically identify bulleted, numbered, outline, and multi-level lists.
How to test
Have lists been programmatically identified?
To check whether lists are programmatically identified:
· Open the Reveal Formatting pane: SHIFT + F1 ..
· Select various list items in the document.
· Bulleted items
· Numbered items
· Outlined items (i.e., items with a hierarchy, such as 2.a.iv)
· If the list is programmatically set, the Reveal Formatting Pane will contain information under the Bullets and Numbering heading.
Note: The setting may be Numbered, Bulleted, or Outline
How to fix
To set selected lines and paragraphs as list items:
· Select the text that is a list
[image: ]
· On the Home Tab, in the Paragraph Group, use the desired settings, either:
· Bullets
· Numbering
· Multilevel Lists
[image: ] 
Note: Plain bullets and numbers are more accessible than pictographic/’fancy' bullets and numbers. 
Note: Sub-list can be created programmatically: On the Home Tab, in the Paragraph Group, select Increase Indent.
[image: ] 
Note: Styles can be used to to set up and control bulleted and numbered lists. However, it is not possible to control Multilevel lists with Styles. Multilevel lists can only be controlled from the Home Tab, Paragraph Group).
[image: ] 
Examples
Correct:
External Link: Correct Example List Formatting in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ListFormatting_eg_correct.doc)
[image: ]
Incorrect:
External Link: Wrong Example List Formatting in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ListFormatting_eg_incorrect.doc)
[image: ]
Rationale
Programmatically identify bulleted, numbered, outline, and multi-level lists.
Lists that are programmatically formatted allow users of assistive technology to easily navigate through and out of list content.
Legal References
508 references:
1194.21(a); 1194.21(d); 1194.31(a); 1194.31(b).
WCAG references:
4.1.2; 3.2.4.
Jump to All Word Requirements, page 108. 
[bookmark: _Complex_Tables_(Merged/Split_1][bookmark: _Complex_Tables_(Merged/Split_2][bookmark: _Complex_Tables_(Merged/Split][bookmark: _Ref314582190][bookmark: _Ref314582192][bookmark: _Toc315358643]Complex Tables (Merged/Split Cells)
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[bookmark: _Language_Settings][bookmark: _Language_Settings_1]Requirements for 508 Compliance
Ensure data cells are associated with the correct header cells.
How to test
Check for merged or split cells. If used, convert to an accessible format.
To check for merged or split cells in data tables:
To look for the presence of merged or split cells, visually inspect the document. 
If Merged or Split Cells are used, convert the file to a PDF for reading.
Note: Because merged and split cells are inherently inaccessible in MS Word, this check must be completed visually.
How to fix
If merged or split cells are used in the document, this requirement is applicable.
Note: It is not possible to programmatically associate merged or split data cells with their associated data headers. The MS Word format does not support this capability.
Fix any other accessibility issues with this MS Word document.
Convert the document to an accessible format for distribution. 
[image: ]
Examples
Not Applicable.
Rationale
Ensure data cells are associated with the correct header cells.
Complex tables may require additional header labeling to maintain the correct relationship for cells and headers.  Merged and split cells can confuse the programmatic associations between data cells and their intended table headers.
Legal References
508 references:
1194.22(g); 1194.22(h); 1194.31(a); 1194.31(b).
WCAG references:
1.3.1-H51.
[bookmark: _Language_Settings_2][bookmark: _Ref314582248][bookmark: _Ref314582250]Jump to All Word Requirements, page 108.
[bookmark: _Ref315160473][bookmark: _Ref315160487][bookmark: _Toc315358644]Language Settings
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[bookmark: _Document_Properties][bookmark: _Document_Properties_1]Requirements for 508 Compliance
Set the appropriate language for passages and phrases that use a language other than the document default.  Exceptions: proper names, technical terms, or foreign words that have become part of the vernacular.
How to test
Is the main language set, and are language changes set for the document?
To examine the languages in the document:
· Open the Reveal Formatting pane:  SHIFT + F1 ..
· Select various places in the document where the default (main) language and other languages are used. Does the correct language show in the language area in the Formatting Pane? 
Note: Each text element should have only one language assigned. Multiple overlapping languages are usually the result of the document’s original author setting multiple languages for editing in their MS Office environment. To resolve this, one main editing language should be set when authoring original documents.
How to fix
To set the language for an individual passage or phrase:
· Select the region of text that differs to the main body of text
[image: ]
· On the Review Tab, in the Language Group, select Language, then Set Proofing Language.
[image: ]
· The Language dialog box opens.
[image: ]
· Choose English (U.S.), or Spanish (International Sort), or other language as appropriate.
Note: The method described above is used to set the language for an individual paragraph. This method can be used to set multiple paragraphs, sections, or even the whole document. However, better results and ‘cleaner’ formatting can be achieved by (1) Adjusting language settings for individual styles; and (2) Setting your editing/proofing language to that of the main text in your document.
Examples 
Correct:
External Link: Correct Example Language Settings in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/LangSetting_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Language Settings in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/LangSetting_eg_incorrect.docx)
[image: ]
Rationale
Set the appropriate language for passages and phrases that use a language other than the document default.  Exceptions: proper names, technical terms, or foreign words that have become part of the vernacular.
Screen readers pronounce words according to the language specified, so if a passage of text is in another language it will mispronounce the words in the passage.
Legal References
508 references:
1194.21(d); 1194.31(a); 1194.31(b).
WCAG references:
3.1.2.
[bookmark: _Document_Properties_2][bookmark: _Ref314582266][bookmark: _Ref314582268]Jump to All Word Requirements, page 108.  
[bookmark: _Ref315160687][bookmark: _Ref315160697][bookmark: _Toc315358645]Document Properties
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[bookmark: _Color_and_Contrast_3]Requirements for 508 Compliance
Set the document title attribute in the document properties.
How to test
Does the Title Metadata property match the document title?
To examine the title field:
· Open the Document Properties panel:  On the File Tab, in the Info Sub-Tab, Select Properties, then from the drop-down select Show Document Panel
· Examine the Title property. Does it match the document’s title?
How to fix
To set the Document Properties:
· Open the Document Properties (“Metadata”) Panel: On the File Tab, in the Info Sub-Tab, Select Properties, then from the drop-down select Show Document Panel
[image: ]
· The Document Properties Panel Opens
[image: ]
· Set the Title property to match the document’s title.
[image: ]
· Set other relevant attributes and information fields as needed (author, keywords etc.).
Note: If the Document Properties Panel only shows the title field, it is because the document is stored on a server. In this case, open the regular properties from the drop-down menu at the top of the panel. Updating the regular properties will also update the server file once it is saved/uploaded.
[image: ]
Examples 
Correct:
External Link: Correct Example Document Properties in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/DocumentProperties_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Document Properties in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/DocumentProperties_eg_incorrect.docx)
[image: ]
Rationale
Set the document title attribute in the document properties.
File names often contain abstract code that confuses users about the purpose of the document. When a document is first opened, screen readers will convey the title rather than the filename when a document title is set in the document properties. Consider adding other document attributes that can assist users as well (author, keywords, organization, etc.) . Match the text in the title attribute to the full title used in the main body of the document.
Legal References
508 references:
1194.21(d); 1194.31(a); 1194.31(b).
WCAG references:
2.4.2.
Jump to All Word Requirements, page 108.
[bookmark: _Color_and_Contrast_4][bookmark: _Ref314582280][bookmark: _Ref314582282][bookmark: _Toc315358646]Color and Contrast
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There are 3 parts to examine:
· HIGH COLOR CONTRAST
· VISIBLE IN CONTRAST MODE
· TEXTUAL EQUIVALENT
[bookmark: _Color_and_Contrast][bookmark: _HIGH_COLOR_CONTRAST][bookmark: _Color_and_Contrast_1]HIGH COLOR CONTRAST
Requirements for 508 Compliance
Use high color contrast (background to foreground contrast, watermark to foreground contrast, etc.). The color contrast ratio between the background and text should be at least 4.5:1.
How to test and fix
Have high contrast combinations been used?
To check contrast:
· Print the document in grayscale and/or turn down the color on the computer monitor
· Examine items to ensure that there is sufficiently high contrast for elements, e.g.:
· Table headers (text versus background fill)
· Text in foreground versus background colors or images
· Text in images
· Watermarks versus text in foreground (the watermark should not interfere with the foreground text, as can happen when there is too little contrast)
Note: this is a subjective test
[image: ]
Note: For this requirement, contrast is being measured in a subjective manner. To have confidence that this requirement is being met, it may prove useful to show the document to a number of people of different ages (contrast sensitivity decreases with age) and visual capabilities. It also may be useful to examine the document under different types of lighting condition (from well lit rooms down to low light situations).
Examples
Correct:
External Link: Correct Example HIGH COLOR CONTRAST in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast1_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example HIGH COLOR CONTRAST in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast1_eg_incorrect.docx)
[image: ]
Rationale
Use high color contrast (background to foreground contrast, watermark to foreground contrast, etc.). The color contrast ratio between the background and text should be at least 4.5:1.
Users with low vision and color blindness may have difficulty reading documents that do not present sufficient contrast and color difference between background and foreground elements.
Legal References
508 references:
1194.21(g); 1194.21(i); 1194.22(c); 1194.31(a); 1194.31(b).
WCAG references:
1.4.1 Use of Color; 1.4.3 Contrast (minimum); WCAG-AAA: 1.4.6 ; 1.4.8.
Jump to All Word Requirements, page 108.
[bookmark: _VISIBLE_IN_CONTRAST][bookmark: _VISIBLE_IN_CONTRAST_2]VISIBLE IN CONTRAST MODE
Requirements for 508 Compliance
Text, images, and non-decorative graphics (bullets, dividers, etc.) must be visible when viewed in "High Contrast" mode.
How to test and fix
Are items visible in High Contrast Mode?
To ensure that text displays well in High Contrast Mode:
· When choosing font colors, use the Automatic setting. Text that is set to Automatic will render properly in High Contrast mode.
[image: ] 
To ensure that non-text elements display well in High Contrast Mode:
· Print out a copy of the document for comparison with the screen display
· Turn on High Contrast Mode: Left Alt + Left Shift + Print Screen
[image: ]
· Check that items are still easily visible, e.g.:
· Bullet characters
· Graphics
· Table borders
· Information conveyed through color
· Adjust color settings accordingly
Note: It may be necessary to switch between High Contrast and regular viewing modes a number of times during this process.
Examples
Correct:
External Link: Correct Example VISIBLE IN CONTRAST MODE in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast2_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example VISIBLE IN CONTRAST MODE in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast2_eg_incorrect.docx)
[image: ]
Rationale
Text, images, and non-decorative graphics (bullets, dividers, etc.) must be visible when viewed in "High Contrast" mode.
Users with low vision must be able to see the document content when displayed in “High Contrast” mode.
Legal References
508 references:
1194.21(g); 1194.21(i); 1194.22(c); 1194.31(a); 1194.31(b).
WCAG references:
1.4.1 Use of Color; 1.4.3 Contrast (minimum); WCAG-AAA: 1.4.6 ; 1.4.8.
[bookmark: _VISIBLE_IN_CONTRAST_1][bookmark: _Color_and_Contrast_2]Jump to All Word Requirements, page 108.
[bookmark: _TEXTUAL_EQUIVALENT][bookmark: _Unclear_Hyperlink_Text][bookmark: _TEXTUAL_EQUIVALENT_1]TEXTUAL EQUIVALENT
Requirements for 508 Compliance
Information conveyed through color must also be conveyed textually.
How to test and fix
Is information conveyed through color also be conveyed textually?
To examine information for color redundancy:
· Identify elements where color is used to convey meaning, e.g.:
· Pie charts
· Bar charts
· Table data cells (text and background/fill)
· Figures
· Status (statements, indicators)
· Instructions
· Flowcharts
· Determine whether there is a text equivalent used to convey the same information.
[image: ]
· Add a text equivalent on or adjacent to the element that conveys the same information.
[image: ]
Note: Information conveyed in text may be placed in the alt-text, but it should not be the only place that the text is shown. The information should be clearly visible at all times for all users of the interface. Using alt-text attributes to “pop up” information normally conveyed in color is inappropriate, because people who have color vision problems are not required to have their interface set to show alt-text on mouse-over.
Examples
Correct:
External Link: Correct Example TEXTUAL EQUIVALENT in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast3_eg_correct.docx) 
[image: ]
Incorrect:
External Link: Wrong Example TEXTUAL EQUIVALENT in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ColorAndContrast3_eg_incorrect.docx) 
[image: ]
Rationale
Information conveyed through color must also be conveyed textually.
Users who are blind, low vision, or color blind require alternatives for information conveyed by color. In addition to static colors, this includes color used to indicate dynamic changes in status, alerts, errors, etc.
Legal References
508 references:
1194.21(g); 1194.21(i); 1194.22(c); 1194.31(a); 1194.31(b).
WCAG references:
1.4.1 Use of Color; 1.4.3 Contrast (minimum); WCAG-AAA: 1.4.6 ; 1.4.8.
Jump to All Word Requirements, page 108.
[bookmark: _Running_the_Automated][bookmark: _Ref314582293][bookmark: _Ref314582295][bookmark: _Toc315358647]Running the Automated Accessibility Checker
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1. Save your document in the correct format 
(A) Before using the checker, you need to save your document from within Word 2010 in .docx format
(B) When you save your document, the option to “Maintain compatibility with previous versions of Word” may be shown. If shown, make sure that it remains unchecked.
[image: ]
If you do not follow steps A and B above, the following error will show when you try to run the checker: 
[image: ]
Note: If you must have a .doc file format (e.g., for policy reasons), save in the .docx format first, run the checks, and then save the checked / fixed document in the desired format). 
2.  Run the Accessibility Checker
(A) Select Check Accessibility from the File Tab: On the File Tab, in the Info Sub-Tab, select Check for Issues, then select Check Accessibility from the drop-down list.
[image: ]
(B) The Accessibility Checker Pane Opens. 
[image: ]
[bookmark: _Unclear_Hyperlink_Text_1][bookmark: _Ref314582329][bookmark: _Ref314582330][bookmark: _Ref314582341][bookmark: _Toc315358648]Unclear Hyperlink Text
[image: ]
[bookmark: _Unstructured_Document]Requirements for 508 Compliance
Use meaningful plain language for links and/or user controls. The name must describe the destination, function, and/or purpose of the user interface. Links and controls that repeat the same name should provide a unique and specific description for each.
How to test
Do links have functional target-specific destinations?
To examine the functional target of links:
· First, run the checker:
· To look for the presence of more than just a URL on links, Run the accessibility checker: “Unclear Hyperlink Text”
· Second, examine links individually:
· Go through the links to verify that unique, plain-language target-specific descriptions are given for each link.
Form fields: 
To check if the document is a form / contains form elements:
· Examine the document for form fields, e.g.:
· Checkboxes
· Radio Buttons
· Combo boxes
· Fillable text fields
· Interactive elements
Note: Word is an inappropriate format for electronic forms. If found, the document needs to be in a different (accessible) format for reading.
How to fix
To provide a functional target-specific destination for links:
· Select the text that is (or is to be) the link.
[image: ]
· Open the context menu (right click)
[image: ]
· Select Hyperlink
· The Insert Hyperlink dialog box appears
[image: ]
· In the Text to Display field, enter the functional, target specific destination in plain English. 
[image: ]
Note: For documents that are also intended for printing, the link/URL can also be appended at the back of the plain English name.
[image: ]
Note: Links and controls that repeat the same name should provide a unique and specific description for each.
[image: ]
Form fields: 
This requirement is not applicable, as Word is an inappropriate format for electronic forms. 
Examples
Correct:
External Link: Correct Example Unclear Hyperlink Text in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/UnclearHyperlinkText_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Unclear Hyperlink Text in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/UnclearHyperlinkText_eg_incorrect.docx)
[image: ]
Rationale
Use meaningful plain language for links and/or user controls. The name must describe the destination, function, and/or purpose of the user interface. Links and controls that repeat the same name should provide a unique and specific description for each.
Users need to know the unique target or function of an interface. Sometimes the name or text of the link is sufficient and/or confusing. Users will need a unique name for links and/or user controls that repeat the same name but serve different purposes (i.e. when a link ‘Here’ appears multiple times give the link a unique description.)
Legal References
508 references:
1194.21(d); 1194.21(f); 1194.22(a); 1194.22(l); 1194.31(a); 1194.31(b); 1194.21(c).
WCAG references:
4.1.2; 1.3.2 ; 2.4.3.
Jump to All Word Requirements, page 108.
[bookmark: _Unstructured_Document_1][bookmark: _Unstructured_Document_2][bookmark: _Ref314582312][bookmark: _Ref314582314][bookmark: _Ref314582353][bookmark: _Ref314582354][bookmark: _Toc315358649]Unstructured Document
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[bookmark: _Skipped_Heading_Level][bookmark: _Skipped_Heading_Level_1]Requirements for 508 Compliance
Use programmatically discoverable headings to logically structure content.
How to test
Are heading styles used to logically divide and structure the document?
To check if heading styles have been used:
· To look for the presence of a headings styles, Run the accessibility checker: “Unstructured Document” will show if headings are not set correctly on a long document.
Note: The above check only works on documents of about 1200 words or more. If headings are used on shorter documents, use the manual check described below.
To check that all headings are marked:
· Open the headings (navigation) pane: On the View Tab, in the Show Group, Select Navigation Pane.
· The headings in the navigation page should be selectable to go to any heading in the document.
· The hierarchy of the headings in the document should be indicated in the Document Map.
How to fix
To set headings programmatically:
· In the document, select the text that is to be set as a heading.
[image: ]
· Open the Styles Pane: CTRL + ALT + SHIFT + S .
[image: ]
Note: It is best to use the built-in styles named ‘Heading 1’, ‘Heading 2, ‘Heading 3’ etc., because these styles work well with assistive technologies used by people with disabilities. If ‘Heading 1’, ‘Heading 2’ etc. do not show in the Styles Pane, select the Options button in the bottom right corner of the pane, and set the types of styles that show to ‘All Styles’.
· Find the appropriate style name (Title, or Heading 1, heading 2, heading 3 etc.). Open the context menu (right click) for the style name.
· If necessary, update a heading style to match any current visual character formatting. Choose Update <style name> to Match Selection
[image: ]
· If necessary, modify the heading style’s settings to match your desired formatting. Choose Modify…
[image: ]
· Apply the heading style to the selected text. Select the heading style name, and the selected paragraph in the main document will be programmatically marked with the style name.
[image: ]
Tip: The Navigation Pane can be used to visualize Heading settings while they are being set: On the View Tab, in the Show Group, Select Navigation Pane.
[image: ]
Examples
Correct:
External Link: Correct Example Unstructured Document in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/UnstructuredDocument_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Unstructured Document in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/UnstructuredDocument_eg_incorrect.docx)
[image: ]
Rationale
Use programmatically discoverable headings to logically structure content.
The use of styles and/or other programming allows keyboard-only and assistive technology users to navigate content.  Applying bigger fonts, bold, underline, italic etc. does not programmatically set text as a heading.
Legal References
508 references:
1194.21(a); 1194.21(d); 1194.22(o); 1194.31(a); 1194.31(b); 1194.31(f).
WCAG references:
1.3.1 ; 2.1.1; 2.4.6 ; WCAG-AAA: 2.4.10 Section Headings.
Jump to All Word Requirements, page 108.
[bookmark: _Skipped_Heading_Level_2][bookmark: _Ref314582369][bookmark: _Ref314582372][bookmark: _Toc315358650]Skipped Heading Level
[image: ]
[bookmark: _Repeated_Blank_Characters]Requirements for 508 Compliance
Use programmatically discoverable headings to logically structure content.
How to test
Are heading styles used to logically divide and structure the document?
To check if a logical heading structure has been used:
· To examine the heading structure, Run the accessibility checker: “Skipped Heading Level” will show if headings are not set correctly.
To check the heading structure:
· To view the current structure, open the headings (navigation) pane: On the View Tab, in the Show Group, Select Navigation Pane.
Note: Only headings that have been properly formatted with heading styles will show in the Navigation Pane. All headings should have a heading style applied and should show in the Navigation Pane. For instruction on setting heading styles, see the guidance for Unstructured Document, page 52.
How to fix
To set a logical structure:
· Open the Outline View: On the View Tab, in the Document Views Group, select Outline.
[image: ]
· The Outlining Tab opens in the Ribbon. The document is shown in Outline View.
[image: ]
· Use the controls in the Outlining Tab to set a logical heading structure. The level of the heading under the cursor is shown in the Outline Tools Tab. The controls in the Outlining Tab can be used to promote/demote headings, move headings within the document, show or hide formatting, and more. 
Note: A logical structure will mean that ‘jumps’ in heading level are eliminated (or at least minimized). For example, Heading 1 precedes Heading 2, which precedes Heading 3.
Tip: The Navigation Pane can also be used to visualize Heading settings while they are being set: On the View Tab, in the Show Group, Select Navigation Pane. Use the context menu (right click) within the Navigation Pane to promote or demote headings.
Examples
Correct:
External Link: Correct Example Skipped Heading Level in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/SkippedHeadingLevel_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Skipped Heading Level in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/SkippedHeadingLevel_eg_incorrect.docx)
[image: ]
Rationale
Use programmatically discoverable headings to logically structure content.
The use of styles and/or other programming allows keyboard-only and assistive technology users to navigate content.  Applying bigger fonts, bold, underline, italic etc. does not programmatically set text as a heading.
Legal References
508 references:
1194.21(a); 1194.21(d); 1194.22(o); 1194.31(a); 1194.31(b); 1194.31(f).
WCAG references:
1.3.1 ; 2.1.1; 2.4.6 ; WCAG-AAA: 2.4.10 Section Headings.
Jump to All Word Requirements, page 108.
[bookmark: _Repeated_Blank_Characters_1][bookmark: _Ref314582381][bookmark: _Ref314582383][bookmark: _Toc315358651]Repeated Blank Characters
[image: ]
Requirements for 508 Compliance
Use paragraph spacing settings instead of carriage returns when additional line spacing is needed between paragraphs.
How to test
Have carriage returns been used in place of paragraph spacing formatting?
To determine whether multiple blank characters have been used for spacing/layout:
· Run the accessibility checker: “Repeated blank characters”
How to fix
To show/find Repeated Blank Characters
· Show blank (non-printing) Characters:  CTRL +  SHIFT +  * .
[image: ]
· Repeated blank characters that need to be removed and replaced are:
· Paragraph marks
[image: ]
· Manual line break marks
[image: ]
· Tab Characters
[image: ]
· Spaces.
[image: ]
To remove and replace repeated paragraph marks (and manual line break marks)
· Delete unnecessary blank characters
· Select the remaining single paragraph mark (or select the single paragraph)
· On the Page Layout Tab, in the Paragraph Group, select the Spacing options for Before and/or After the selected paragraph. (e.g., If the font is 12pt high, and 4 blank lines After are to be replaced, set After to 48pt).
[image: ]
Note: There should be only one paragraph marker per paragraph, as a general rule.
Note: To control different types of paragraph spacing for a large document, it is easiest to use the Paragraph settings in Styles.
To remove and replace repeated Tab Characters and Spaces used for indenting text
· Delete unnecessary blank characters
· Select the paragraph
· On the Page Layout Tab, in the Paragraph Group, select the Indent options for the selected paragraph. 
[image: ]
Note: It may be useful to show the Ruler when setting indents: In the View Tab in the Show Group, Select Ruler.
[image: ]
Note: To control different types of Indents for a large document, it is easiest to use the Paragraph settings in Styles.
To remove and replace repeated Tab Characters and Spaces used for setting columns
· Delete unnecessary blank characters and move any errant text so that it becomes one continuous paragraph
[image: ]
· Select the paragraph
[image: ]
· On the Page Layout Tab, in the Page Setup Group, select Columns. Choose a preconfigured option from the list, or choose More Columns… to set your own column preferences.
[image: ]
· If More Columns… is chose, the Columns dialog box appears. Set your preferences in the dialog box.
[image: ] 
· The selected text is correctly set in columns.
[image: ]
Note: Setting paragraphs of text in columns also divides the content into sections. Section break characters will also appear if non-printing Characters are showing:  CTRL +  SHIFT +  * .
Examples
Correct:
External Link: Correct Example Repeated Blank Characters in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/RepeatedBlankChar_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Repeated Blank Characters in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/RepeatedBlankChar_eg_incorrect.docx)
[image: ]
Rationale
Use paragraph spacing settings instead of carriage returns when additional line spacing is needed between paragraphs.
Excess carriage returns are spoken by screen readers, interfering with normal reading.
Legal References
508 references:
1194.31(b).
WCAG references:
WCAG-AAA: 1.4.8.
Jump to All Word Requirements, page 108.
[bookmark: _Object_Not_Inline][bookmark: _Ref314582393][bookmark: _Ref314582396][bookmark: _Toc315358652]Object Not Inline
[image: ]
[bookmark: _Objects_Not_Inline][bookmark: _No_Header_Row][bookmark: _No_Header_Row_1]Requirements for 508 Compliance
Place images, data tables, charts, and other objects ‘inline’ with the document content (rather than ‘floating’). Where floating objects are unavoidable, ensure both the object and wrapped text around the object are part of the read order.
How to test
Are objects inline with text?
To examine whether items are inline with document content:
· Run the accessibility checker: “Object Not Inline”
How to fix
To set a picture or drawing object as ‘inline’:
Select the floating item (‘floating’ is the opposite of ‘inline’), then open the context menu (right click).
Select Wrap text, then select In Line with Text
[image: ]
The object is set to be Inline with text
Remove any blank character formatting of text that was behind the original floating object. It may be useful to show blank characters: CTRL+ SHIFT + * . Apply regular character and/or paragraph formatting to the object to return it to the desired visual look (an inline object behaves like a text character).
[image: ]
Note: Some visual layout effects are not possible when objects are set as ‘inline’ For example, text cannot be wrapped around an object. If floating objects are absolutely necessary, then (1) fix any remaining accessibility issues with the document, and (2) convert the file to an accessible format (one in which floating objects can be made accessible).
To set a data table as ‘inline’:
Select the table, then open the context menu (right click).
Select Table Properties…
The Table Properties dialog box opens.
In the Table Properties dialog box, Table Tab, set Text wrapping to None.
[image: ] 
Note: Some visual layout effects are not possible when objects are set as ‘inline’ For example, text cannot be wrapped around an object. If floating objects are absolutely necessary, then (1) fix any remaining accessibility issues with the document, and (2) convert the file to an accessible format (one in which floating objects can be made accessible).
To set a Text Box as ‘inline’ (do not use Text Boxes):
Note: The content of text boxes does not get read by screen reading software used by people who are non-sighted or who have low vision. Therefore, it is never acceptable to use text boxes in documents that are intended to be distributed in MS Word format. If text box use is absolutely necessary for layout, it is necessary to convert the file to an accessible format.
Examples
Correct:
External Link: Correct Example Object Not Inline in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ObjectNotInline_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Object Not Inline in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/ObjectNotInline_eg_incorrect.docx)
[image: ]
Rationale
Place images, data tables, charts, and other objects ‘inline’ with the document content (rather than ‘floating’). Where floating objects are unavoidable, ensure both the object and wrapped text around the object are part of the read order.
Screen readers can only detect and properly read objects when they are placed 'inline'. Assistive technologies must present users with the correct reading order when text wrapping is used or content may be read in a confusing manner (line of text, followed by a table row, followed by a line of text, etc.)
Legal References
508 references:
1194.21(a); 1194.31(a); 1194.31(b); 1194.31(f).
WCAG references:
2.4.3.
Jump to All Word Requirements, page 108.
[bookmark: _No_Header_Row_2][bookmark: _Ref314582417][bookmark: _Ref314582419][bookmark: _Toc315358653]No Header Row Specified
[image: ]
[bookmark: _Blank_Table_Rows]Requirements for 508 Compliance
Identify column and row header cells programmatically.
How to test
Data in Columns:
Are data column header cells identified in the first row?
To check the identification on the first row:
To look for the presence of a marked Header Row, Run the accessibility checker: “No Header Row Specified” will show if it is not set correctly.
Note: The data tables must be formatted with Table Grid style for this check to work. To inspect a table to determine its’ style, select the table, then open the Reveal Formatting Pane:  SHIFT + F1 .
Data in Rows:
Are data row header cells used in the first column? If used, convert to a an accessible format.
To check row headers in data tables:
Inspect the table headers and data to determine if row headers have been employed in the first column. 
If the first column must contain row headers, convert the document to an accessible format for distribution.
How to fix
Data in Columns:
To identify the first row as column data headers:
· Select the first row of the table
[image: ]
· On the Layout Sub-Tab (of the Table Tools Tab), in the Data Group, select Repeat Header Rows.
[image: ]
· The Repeat Header Rows button remains highlighted when set (and the cursor is placed in the header row).
[image: ]
Note: In addition to identifying the header row, this function also makes header appear on each new page (where a table spans more than one page).
Data in Rows:
To identify the first column as row data headers:
[image: ]
This cannot be done in MS Word. If the first column must contain row headers:
· Fix any other accessibility issues with this MS Word document.
· Convert the document to an accessible format for distribution. 
Examples
Correct:
External Link: Correct Example No Header Row Specified in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/NoHeaderRowSpecified_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example No Header Row Specified in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/NoHeaderRowSpecified_eg_incorrect.docx)
[image: ]
Rationale
Identify column and row header cells programmatically.
Sighted users can visually scan up and across a data table to find row and column headers. Correctly labeling rows and columns headers allows non-sighted users can make this association.
Legal References
508 references:
1194.22(g); 1194.22(h); 1194.31(a); 1194.31(b).
WCAG references:
1.3.1-H51.
Jump to All Word Requirements, page 108.
[bookmark: _Blank_Table_Rows_1][bookmark: _Ref314582429][bookmark: _Ref314582431][bookmark: _Toc315358654]Blank Table Rows or Columns
[image: ]
[bookmark: _Missing_Alt_Text]Requirements for 508 Compliance
Ensure data cells are associated with the correct header cells.
How to test
Check for Blank Table Rows or Columns
To determine whether blank Table Rows or Columns have been used for spacing/layout:
Run the accessibility checker: “Blank Table Rows or Columns”
How to fix
Note: If a data table row or column is blank, it is usually set that way for visual formatting purposes (e.g., to make a thick, bold border between rows). These blank rows or columns contain no data, and therefore cannot be associated with any header cells. Blank rows or columns need to be identified and then removed. After removal, the desired visual formatting can be applied with table border controls.
[image: ]
Find blank table rows or columns:
Viewing the table with gridlines showing and formatting cleared will visually reveal blank rows or columns:
[image: ]
To view Table Gridlines, place the cursor anywhere in the table, then in the Table Tools Tab, in the Layout Sub-Tab, in the Table Group, select View Gridlines.
[image: ]
To clear formatting for the table, in the Table Tools Tab, in the Design Sub-Tab, in the Table Styles Group, select the More (drop-down) icon, and then select Clear from the bottom of the drop-down.
[image: ]
Note: After inspecting the table, formatting can be reapplied by selecting the ‘Undo’ control. Alternatively, prior to clearing table formatting, any desired formatting for a table can be saved as a ‘New Table Style’ in the drop-down list described above. The new style can then be reapplied after inspecting the table for blank rows or columns.
Fix blank table rows or columns:
First, delete blank columns or rows: Place the cursor in the column or row to be deleted. In the Table Tools Tab, in the Layout Sub-Tab, in the Rows & Columns Group, select Delete.
[image: ] 
Next, use the various borders and shading controls in the Table Tools Tab, Design Sub-Tab to re-do the desired visual formatting.
[image: ] 
Note: It is acceptable to have a table containing a column of blank data cells, as long as there is a data header cell.
[image: ] 
Examples
Correct:
External Link: Correct Example Blank Table Rows or Columns in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/BlankTableRowsOrColumns_eg_correct.docx)  
[image: ]
Incorrect:
External Link: Wrong Example Blank Table Rows or Columns in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/BlankTableRowsOrColumns_eg_incorrect.docx) 
[image: ] 
Rationale
Ensure data cells are associated with the correct header cells.
Complex tables may require additional header labeling to maintain the correct relationship for cells and headers. Merged and split cells can confuse the programmatic associations between data cells and their intended table headers.
Legal References
508 references:
1194.22(g); 1194.22(h); 1194.31(a); 1194.31(b).
WCAG references:
1.3.1-H51.
Jump to All Word Requirements, page 108.
[bookmark: _Missing_Alt_Text_2][bookmark: _Missing_Alt_Text_5][bookmark: _Ref314582442][bookmark: _Ref314582447][bookmark: _Toc315358655]Missing Alt Text (Tables)
[image: ]
[bookmark: _Missing_Alt_Text_1]Requirements for 508 Compliance
Use a summary or a caption when displaying data tables.
How to test
Check to see if a caption or alternate text summary has been added to data tables
To determine whether Alternate Text has been applied to a Data Table
Run the accessibility checker: “Missing Alt Text: Tables”
Note: This test only works when the Table style is set to ‘Table Grid’.
To determine whether a caption has been applied to a Data Table
On the References Tab, in the Captions Group, Select Cross-reference
The Cross-reference Dialog Box appears
If tables have proper cross-references then the tables will show in this dialog box.
Note: This requirement is for either a caption or an alternate text summary, but having both a caption and a summary is more accessible.
How to fix
To add an alternate text description to a data table
Place the cursor anywhere in the table
On the Table Tools Tab, in the Layout Sub-Tab, in the Table Group, Select Properties
[image: ]
The Table Properties Dialog Box appears
In the Alt Text Tab of the Table Properties Dialog Box, insert text in the Description field. The text should orient a non-sighted user on the table’s design and content.
[image: ] 
Note: The Title field is not necessary for accessibility. It can be left blank.
To add a caption to a data table
Place the cursor anywhere in the table
On the References Tab, in the Captions Group, Select Insert Caption
[image: ]
The Caption Dialog Box appears
[image: ] 
Enter a descriptive caption in the Caption field. The caption description should ideally make sense when spoken in isolation. This makes it easy for screen reader users to access and use a list of tables.
Note: Once a caption has been added to a table, it can be programmatically cross-referenced from elsewhere in the document. Cross-referencing ensures that table numbers are correct even when new tables are added, or tables deleted. Cross-referencing also makes it easier for people with low or no vision to navigate the document. To add a cross reference to a data table:
Place the cursor where the cross-reference is to go in the text of the document
On the References Tab, in the Captions Group, Select Cross-reference
[image: ]
The Cross-reference Dialog Box appears
Select the desired cross-reference options
[image: ] 
The cross-reference becomes a selectable, navigable item in the document’s text
[image: ]
Examples
Correct:
External Link: Correct Example Missing Alt Text (Tables) in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/Missing_Alt_Text_Table_eg_correct.docx)
[image: ]
Incorrect:
External Link: Wrong Example Missing Alt Text (Tables) in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/Missing_Alt_Text_Table_eg_incorrect.docx)
[image: ]
Rationale
Use a summary or a caption when displaying data tables.
Sighted users can quickly scan tables to understand their purpose, but many assistive technology users navigate with the keyboard. These users need a table summary or caption to describe the purpose of a table.
Legal References
508 references:
1194.22(a); 1194.31(a); 1194.31(b).
WCAG references:
No WCAG coverage.
Jump to All Word Requirements, page 108.
[bookmark: _Missing_Alt_Text_3][bookmark: _Missing_Alt_Text_4][bookmark: _Ref314582459][bookmark: _Ref314582461][bookmark: _Toc315358656]Missing Alt Text (Picture, Text Box, Other elements)
[image: ]
[bookmark: _Legal/508_“fine_print”]Requirements for 508 Compliance
Provide alternative text or descriptions for non-decorative images, images within a link, form fields, and other interface elements.
How to test
Check whether alternate text has been used and is appropriate / sufficient
To examine alternate text for images:
To look for the presence of alternate text, Run the accessibility checker: “Missing Alt Text”
Use SSA’s “Alt text for images guide” to determine whether the alternate text is appropriate / sufficient
Note: Null alt text (no alt text or a single space character) is acceptable for decorative and redundant images, although an error will be generated in the checker.
How to fix
Add alternate text for pictures, charts, shapes etc.:
Select the item, then open the context menu (right click), select Format…
[image: ]
The Format dialog box opens.
In the Format dialog box, Alt Text Tab, add the alternate text in the Description field. Give the purpose and function of the picture within the context of the surrounding information. Avoid putting redundant and/or irrelevant information into the alternate text.
[image: ]
Note: The Title field is not necessary for accessibility. It can be left blank.
Note: A detailed guide is available for determining content for alternative text in different situations (see section entitled “Follow detailed guidance for alternate text:”, on page 105).
For images depicting text
When an image depicts text, the alternative text for the image should use the text in the image.
Give the purpose and function of the picture within the context of the surrounding information. Also provide any text shown in the image, verbatim.
[image: ]
Note: A detailed guide is available for determining content for alternative text in different situations (see section entitled “Follow detailed guidance for alternate text:”, on page 105).
Remove alternative text for decorative or formatting images
Supply a null alternative text value for decorative or formatting images (ALT="") so they are skipped by assistive technologies.
[image: ]
 Note: Null alt text (no alt text or a single space character) is acceptable for decorative and redundant images, although an error will be generated in the checker.
Note: A detailed guide is available for determining content for alternative text in different situations (see section entitled “Follow detailed guidance for alternate text:”, on page 105).
Text boxes (do not use Text Boxes):
Note: The content of text boxes does not get read by screen reading software used by people who are non-sighted or who have low vision. Therefore, it is never acceptable to use text boxes in documents that are intended to be distributed in MS Word format. If text box use is absolutely necessary for layout, it is necessary to convert the file to an accessible format.
[bookmark: _Follow_detailed_guidance][bookmark: _Follow_detailed_guidance_1][bookmark: _Ref315162798]Follow detailed guidance for alternate text:
[image: ] 
Use SSA’s “Alternate text for images guide”  to determine content for alternative text in different situations. The guide covers the following topics:
Conveying purpose and function of a picture
Appropriate length and level of detail to use
Common mistakes
Specific guidance for different types of picture, including
Portraits (head-shots)
Charts, diagrams and illustrations
Logos
Text contained in an image
Text rendered as an image
Bullets
Spacers (structural images)
Lines, horizontal rules, and separators
Decorative images
Background images
Watermarks
Signatures
Complex / ungrouped / tiled / layered images
Examples
Correct:
External Link: Correct Example Missing Alt Text (Picture, Text Box, Other elements) in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/Missing_Alt_Text_Picture_eg_correct.docx) 
[image: ]
Incorrect:
External Link: Wrong Example Missing Alt Text (Picture, Text Box, Other elements) in Word (http://www.socialsecurity.gov/accessibility/checklists/docs/Missing_Alt_Text_Picture_eg_incorrect.docx) 
[image: ]
Rationale
Provide alternative text or descriptions for non-decorative images, images within a link, form fields, and other interface elements.
People who are blind or have low vision may need additional information presented as text so they can access information and control interface elements.  Complex images may require detailed descriptions to convey important or useful information. For instance, provide a more detailed description for a chart demonstrating a growth trend.
Legal References
508 references:
1194.21(d); 1194.21(f); 1194.22(a); 1194.22(i); 1194.22(l); 1194.22(n); 1194.31(a); 1194.31(b).
WCAG references:
1.1.1-H37.
Jump to All Word Requirements, page 108.
[bookmark: _Legal/508_“fine_print”_1][bookmark: _All_Word_Requirements][bookmark: _Ref314667518][bookmark: _Ref314667528][bookmark: _Toc315358657]All Word Requirements
This table contains SSA's Accessibility Requirements for Microsoft Word
	No.
	Requirement
	Rationale
	Section 508
Mapping
	Instructional Help

	1
	Document Properties

	1.1
	Set the document title attribute in the document properties.
	File names often contain abstract code that confuses users about the purpose of the document. When a document is first opened, screen readers will convey the title rather than the filename when a document title is set in the document properties. Consider adding other document attributes that can assist users as well (author, keywords, organization, etc.). Match the text in the title attribute to the full title used in the main body of the document.
	1194.21(d);
1194.31(a);
1194.31(b)
	Document Properties, page 23

	2
	Language Settings

	2.1
	Set a default language attribute for the document.
	Screen readers pronounce words according to the language specified. Problems occur when the language has not been set at all, or it has been set to the wrong language.
	1194.21(d);
1194.31(a);
1194.31(b)
	None for Word

	2.2
	Set the appropriate language for passages and phrases that use a language other than the document default. Exceptions: proper names, technical terms, or foreign words that have become part of the vernacular.
	Screen readers pronounce words according to the language specified, so if a passage of text is in another language it will mispronounce the words in the passage.
	1194.21(d);
1194.31(a);
1194.31(b)
	Language Settings, page 18

	
3
	Page Layout

	3.1
	Place images, data tables, charts, and other objects ‘inline’ with the document content (rather than ‘floating’). Where floating objects are unavoidable, ensure both the object and wrapped text around the object are part of the read order.
	Screen readers can only detect and properly read objects when they are placed 'inline'. Assistive technologies must present users with the correct reading order when text wrapping is used or content may be read in a confusing manner (line of text, followed by a table row, followed by a line of text, etc.).
	1194.21(a);
1194.31(a);
1194.31(b);
1194.31(f)

	Object Not Inline, page 74

	3.2
	Format columns and page structure to present a proper reading order to assistive technologies (do not rely on tables, TAB characters, etc.).
	When TAB characters are used to visually separate text and make it appear like columns, the reading order is garbled for screen reader users. Programmatic column formatting will maintain the correct reading order. Also, horizontal formatting of vertically arranged letters is difficult for low vision users to read, and since the text can be read one letter at a time, confusing for screen reader users.
	1194.21(a);
1194.21(c);
1194.31(a);
1194.31(b);
1194.31(f)
	




	4
	Document Structure
	
	Document Structure

	4.1
	Use programmatically discoverable headings to logically structure content, and avoid the skipping of heading levels.
	The use of styles and/or other programming allows keyboard-only and assistive technology users to navigate content. Applying bigger fonts, bold, underline, italic etc. does not programmatically set text as a heading. Skipped heading levels may lead screen reader users to believe there is missing information in the document.
	1194.21(a); 1194.21(d); 1194.22(o); 1194.31(a); 1194.31(b); 1194.31(f)
	Unstructured Document, page 52
Skipped Heading Level, page 58

	5
	Paragraphs

	5.1
	Use paragraph spacing settings instead of carriage returns when additional line spacing is needed between paragraphs.
	Excess carriage returns are spoken by screen readers, interfering with normal reading.
	1194.31(b)
	Repeated Blank Characters, page 64


	6
	Color Contrast

	6.1
	Use high color contrast (background to foreground contrast, watermark to foreground contrast, etc.). The color contrast ratio between the background and text should be at least 4.5:1.
	Users with low vision and color blindness may have difficulty reading documents that do not present sufficient contrast and color difference between background and foreground elements.
	1194.31(b)
	Color and Contrast, page 30

	6.2
	Text, images, and non-decorative graphics (bullets, dividers, etc.) must be visible when viewed in "High Contrast" mode.
	Users with low vision must be able to see the document content when it is displayed in “High Contrast” mode.
	1194.21(g);
1194.31(b)
	Color and Contrast, page 30

	7
	Lists and Outlines

	7.1
	Programmatically identify bulleted, numbered, outline, and multi-level lists.
	Lists that are programmatically formatted allow users of assistive technology to easily navigate through and out of list content.
	1194.21(a);
1194.21(d);
1194.31(a);
1194.31(b)
	List Formatting, page 9

	8
	Data Tables

	8.1
	Use a summary or a caption when displaying data tables.
	Sighted users can quickly scan tables to understand their purpose, but many assistive technology users navigate with the keyboard. These users need a table summary or caption to describe the purpose of a table.
	1194.22(a); 1194.31(a); 1194.31(b)
	Missing Alt Text (Tables), page 94

	8.2
	Identify column and row header cells programmatically.
	Sighted users can visually scan up and across a data table to find row and column headers. Correctly labeling rows and columns headers allows non-sighted users can make this association.
	1194.22(g);
1194.22(h);
1194.31(a);
1194.31(b)
	No Header Row Specified, page 81

	8.3
	Ensure data cells are associated with the correct header cells.
	Complex tables may require additional header labeling to maintain the correct relationship for cells and headers. Merged cells can confuse the programmatic associations between data cells and their intended table headers.
	1194.22(g);
1194.22(h);
1194.31(a);
1194.31(b)
	Complex Tables (Merged/Split Cells), page 15

	9
	Alternative and Descriptive Text

	9.1
	Provide alternative text or descriptions for non-decorative images, images within a link, form fields, and other interface elements.
	People who are blind or have low vision may need additional information presented as text so they can access information and control interface elements. Complex images may require detailed descriptions to convey important or useful information. For instance, provide a more detailed description for a chart demonstrating a growth trend.
	1194.21(d); 1194.21(f); 1194.22(a); 1194.22(i); 1194.22(l); 1194.22(n);
1194.31(a);
1194.31(b)
	Missing Alt Text (Picture, Text Box, Other elements), page 101

	9.2
	When images depict text, the alternative text for the image should use the text in the image.
	When text is rendered as an image, decoration and styling usually do not convey additional information. Therefore, alternate text and descriptions should read the text depicted in the image. (Note: This is different from text within a larger image, diagram, or chart; see 2.1 and 2.7, which would also apply.)
	1194.21(d); 1194.22(a); 
1194.31(a);
1194.31(b)
	Missing Alt Text (Picture, Text Box, Other elements), page 101

	9.3
	Supply a null alternative text value for decorative or formatting images (ALT="") so they are skipped by assistive technologies.
	Assistive technology users need not hear every instance of decorative images on a page. This information interrupts reading content. Combining tiled and layered images allows a single image to associate with a single description. Images not grouped or combined may needlessly confuse users about what they are reading.
	1194.31(a);
1194.31(b)
	Missing Alt Text (Picture, Text Box, Other elements), page 101

	9.4
	Information conveyed through color must also be conveyed textually.
	Users who are blind, low vision, or color blind require alternatives for information conveyed by color. In addition to static colors, this includes color used to indicate dynamic changes in status, alerts, errors, etc.
	1194.21(i); 1194.22(c);
1194.31(a);
1194.31(b)
	Color and Contrast, page 30

	9.5
	Use meaningful plain language for links and/or user controls. The name must describe the destination, function, and/or purpose of the user interface. Links and controls that repeat the same name should provide a unique and specific description for each.
	Users need to know the unique target or function of an interface. Sometimes the name or text of the link is sufficient and/or confusing. Users will need a unique name for links and/or user controls that repeat the same name but serve different purposes (i.e. when a link ‘Here’ appears multiple times give the link a unique description.)
	1194.21(d); 1194.21(f); 1194.22(a); 1194.22(l);
1194.31(a);
1194.31(b)
1194.21(c)
	Unclear Hyperlink Text, page 46
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